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INTRODUCTION TO ARC VIEW AND SWEDISH MAPS

Requirements
This exercise requires a PC with Windows 95/98 or Windows NT and the GIS software 
ArcView version 3.0 or later. The necessary data area available under the catalogue 
/data/arbetsstuga2000/arcview/metria/rodakartan on the course CD or on the earth server at 
Geocentrum under 
Earth2/_sharedfiles/geoinformatik/data/arbetsstuga2000/arcview/metria/rodakartan.

Objectives 
This exercise will give an introduction to Arc View GIS, data types, menus, buttons and 

tools. To illustrate the exercise different Swedish data sources will be introduced, 
including GSD700 (Geografiska Sverige Data, scale 1:700 000), Röda kartan (scale 
1:250 000) and Gröna kartan (scale 1: 50 000). 

Task
This exercise should result in three maps. The first map should show the different communes
(or parishes) in Örebro county with data from Röda Kartan. You should work with the legend
editor and layout to create a colour scheme and label the communes (or parishes). 

The second map should also include data from GSD700, which you use to create a layout 
where the different counties in Sweden as well as the borders of the Scandinavian countries 
and the ocean are displayed. To pass the exercise you must hand in two maps as specified in 
the exercise.

The third map should be built from Gröna kartan by yourselves.

Part 1 - Röda Kartan

First, you should start ArcView. Use the Windows Start button in the lower left corner and 
choose Programs, Esri and ArcView 3.1. In the Welcome window choose to Open an existing
project. 
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Click in the
“button” to
open an
existing
project. Press
OK.

If you select cancel in the welcome 
window you can still open an existing or
new project by going to the File menu. 

Now you should navigate to the 
…/rodakartan directory as specified in 
the Requirements box above and open 
the project tlan.

Click on the file
tlan.apr to select
it. Press OK.

You should use the path specified 
above, i.e. you must open each of 
the folders until you see the project 
in the rodakartan folder. If you 
double click the tlan.apr it will open
directly. Otherwise click once to 
select it and then press OK.

In the left column of the project window you see the five types of 
documents that constitute ArcView - Views, Tables, Charts, 
Layouts and Scripts. It is important to remember that these 
objects are called documents. When you create a specific view (or
table, chart, layout or script) this becomes an instance of the object 
class view (or table, chart, layout or script). Click Open.

The view Röda kartan contains 3 themes (or layers), of which 2 
are displayed. To the left in the view is the Table Of Content 
(TOC), where you can determine which layers to display, in what 
order to display them, as well as colour etc. The Community theme
Rt_kn94 is active (it appears lifted). You can activate or deactivate
a theme by clicking on its name (not in the box to the left of the 
name). By clicking the check-box to the left of the name you can 

display the theme. Display the lake theme Rt_sj92. If you click the name of the theme and hold 
the left mouse bottom pressed you can drag the theme to another position in the TOC, and thus 
rearrange the order of display. In the view below the line theme (waterways, Rt_vl92.shp) are on 
top of the polygons Rt_sj92 (lakes) and Rt_Kn95 (kommuner or communes). Click the check 
boxes and change the order of themes in the TOC. As you will see (or not see), a line theme must 
be on top of a polygon theme in order to be seen.
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This is the Table 
Of Contents 
(TOC)

The project window 
contains icons for the 
five document types that
build up an ArcView 
application.



You might have noted that 
the TOC for waterways 
Rt_vl92.shp lacks a 
legend. You can hide/show 
legends from the menu - 
under the item Theme. 
Remember to activate the 
theme which legend you 
want to hide/show. You can
activate several themes by 
holding down ctrl-shift 
while clicking the themes 
in the TOC.

Next try the buttons and tools for zooming and panning. If you need more information on how to 
use the buttons and tools have a look in the online manual. 

The buttons execute a function directly when pressed. 
With tools you first have to select the tool and then use the mouse to execute the function.

  If you want to zoom you can either click and drag with the mouse, or just click a point 
which then becomes the new centre, with zooming predefined to 125 %.

Each theme in a view is associated with a table that contains attribute data. Activate the theme 

Kn95.shp and press the Open Table button . The table for Kn95 will open directly.
A table consists of records 
(rows) with one record per 
item in the view, and columns 
which are called fields, that 
contains data on various 
attributes. Select a field by 
clicking it. It should turn 
yellow, as should the 
corresponding item in the view.
Click on the record for 
Hällefors, then click on the 
view and finally click on 

Zoom to Selected . That 
is how that button works. 
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Zoom to full and click on the Label tool . Click on any commune and it will be automatically 

labelled with its name. You can move or delete the label by first selecting the Pointer tool  and
then click the label. Grab the handle to move or press the DELETE key to delete it.

Try the identify tool , press it and point and click at any commune in the view.

You will have noted that the theme 
Rt_vl (vattendrag for water ways) is
of the colour grey, From a 
cartographic point of view light 
blue is preferred. Thus we shall 
change the colour of the theme 
Rt_vl. You change colour via the 
Legend Editor. Open the Legend 
Editor either by double clicking 
Rt_vl in the TOC or by pressing 

the Legend editor button . In 
the legend editor double click on 
the symbol for line. Then double 
click the brush, and choose an 
appropriate colour. To put the 
colour on the theme in the view you
have to press Apply.
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1. Double click
the symbol

2. Click the on 
the  paintbrush

3. Choose an 
appropriate colour

4. Apply

1. Select the identify tool

Click and point at any 
commune



If you want to be able to measure distances in the themes you must set Map Units and Distance 
Units for the view. Under View, select Properties… and choose meters for both parameters. 

Now try the Measure tool . It measures the distance along a line drawn with the mouse. 
Check that the north to south extension of Örebro county is approximately correct.

To be a useful map we must add more thematic layers to our view. The layers that we have worked
with so far are all from ”Röda kartan” produced with the scale 1:250 000. To learn more about all 
the layers available for Röda kartan you can have a look under …
arbetsstuga2000/html/rodkart.htm (on the CD or Earth server) or on the web site for 
Lantmäteriverket (Swedish Survey) - www.lm.se/kartplan. 

To add a theme select View from the menu bar and then Add Theme. You can also add a theme 

by using the Add theme button .

Add the following themes to the View

file content
av94 Allmänna vägar (public roads)
nv88 Naturreservat (nature reserves)
mo88 Militära områden (military areas)
to90 Tätorter (built up area)
fs94 Församlingar (parish)

After you have added the themes the order of drawing will be rather arbitrary, as will the colours. 
Thus rearrange the order, and put more appropriate colours on each theme.
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1. Select View 
Properties.

2. Choose meters for 
Map and Distance Units

3. Press OK



There are themes that need more than colour
in order to facilitate 
Interpretation - for instance public roads. By
putting different colour on different road 
types the theme would reveal more 
information. To do that open the legend 
editor for the theme Av. In the dialogue box 
for Legend type do select Unique value, 
and the select kkod as Classification field. 
To decode the information have a look at …
arbetsstuga2000/html/vaginfo.htm. Then use
the colour scheme to put individual colours 
on the roads. Remember to press Apply, or 
the changes will not be adopted. Also 
change the colour in a similar manner for 
communities and parishes, but instead of 
defining colours individually use one of the 
predefined Colour schemes.

As you will probably also have noted it is quite difficult to see anything if you display all the 
themes simultaneously in a small scale. Thus we shall set the Display properties so that lines 
only display when the scale comes above a certain threshold. This is done under Theme and 

Properties in the menu or by pressing the Theme properties button. . Select Display in the 
content top the left and set Maximum scale to 1:2 000 000.

Check that the setting of 
display properties works as you
want it to. Also set the display 
properties for the other line 
themes if appropriate. Now you
have to decide which of the 
polygons you want to display 
as background - communities 
or parishes. And which of the 
other themes that shall be on 
top of the background.

When you are satisfied with 
your view you shall continue by seeking out lakes within a days biking distance from Garphyttan. 
Let us say that a days biking distance is 30 km round trip. Make sure that the built up theme Rt_to

is active. Press the Find button  and search for Garphyttan.
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1. Select Unique value
as legend type

2. Use Kkod as 
classification field

2. Select Theme properties via the 
Button or the Theme menu

3. Set colours individually

3. Select Display (you must 
scroll to reach it)

3. Or use a colour scheme

4. Set appropriate max
scale

4. Apply

1. Activate the theme for which to 
change display properties



 

Once you have found Garphyttan you have to activate the themes you want to analyse in relation 
to Garphyttan. Thus activate the lake theme Rt_sj92 (hold down Ctrl+Shift to select more than 
one theme). Under Theme in the menu choose Select By Theme and you fill in the dialogue 
boxes.

Again use Zoom to selected
to view the identified lakes 
within biking distance from 
Garphyttan. 

Before finishing working with Röda kartan we shall put on labels and make a Layout. Make Rt_to 
the active theme and select Auto-Label under Theme in the menu. Find the settings in the Auto-
label box that gives the best result. Do the same thing for the Communities (or Parishes if they are
your background), and rearrange the labels to look better if necessary. 

When you have a view that you are satisfied with select Layout under View in the menu. Because 
of the shape of Örebro county it is better to produce the Layout as a portrait. You can create the 
Layout from the Project window as well, but there is a bug in choosing the layout format if you 
select that route. You can edit directly in the layout by using the tools in the Layout document 
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1. Press the Find 
button.

2. Search for Garphyttan.

3. Zoom to 
selected

2. Under Theme choose Select By Theme

1. Activate the themes 
with lakes (Rt_sj92).

3. Select Are Within distance of

4. Select Rt_to as source

5. Set distance to 15000m 
Press New Set.



Graphical User Interface (GUI). For example choose the Pointer tool  and click on the text 
Röda Kartan in the layout, change the text to ”Örebro county” and the scale bar to kilometres for 
instance. You can also change the size of the text. Try to grab some other objects in the layout and 
rearrange them.

Return to the project window and save the project under your working directory. This map should 
be handed to the teachers along with the next one you are now going to produce. You shall now 
create a second view in the same project so do not exit the project.

Part 2 - GSD700

A very common format of GIS-data is the export format of Arc Info - the extension of such files is
.e00. We have the National Atlas of Sweden in the scale 1: 700 000 (GSD 700) available as .e00 
files and we will import them and add them to the existing layout as an overview.

Arc Info export files (.e00) can not be retrieved directly by ArcView, they have to be imported 
with a stand alone program before they can be added. Use the NT explorer to find the program 
called Import71, which is located under …/data/GSD700. Create a short cut of the program icon 
and drop it on your desktop. Start Import71, use the Browse function to navigate to the data 
source (.../data/GSD700). Put the Output Data Source in your directory. Note that for each e00 
file that you import you need to create a new directory (use the same root name as that of the file –
as in the example below where the file Grans is entered into the directory Grans).
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You have to import all the .e00 files individually. The available coverages of the National Atlas 
include

File Content data type
Grans700 Församlingar (Pasrishes) polygon
Kom700 Kommuner (Communes) polygon
Kust700 Ytor - markanvändning (land use) polygons
Lan700 Län (Counties) polygons
Vdrag700 Vattendrag (Streams) arc

Start ArcView and open the project for Örebro county that you just created and create a New 

View. Once you have the View active, choose Add theme, either via the Add theme button , 
or under the View menu (or ctrl-t). The data in GSD700 (Geografiska Sverige Data) are not in the 
standard Arc View format (shape), but are represented as coverages. Each coverage holds a 
theme - however the theme can consist of several layers of different data types (polygons, arcs, 
points, labelpoints, annotations), and you must decide which data type(s) to load for each 
coverage.

When you get the add menu, do select the feature you want to add with one click on the mouse 
(do not double click), and do put the mouse marker over the graphics of the file not over the text! 
The features shadowed by a yellow portfolio are coverages. If you just double click a coverage 
you will get a default choice, which means that you can miss some information when bringing it 
up in Arc View. If you just click once on the graphics for a coverage you should get a subset list of 
available features to add.
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1.Choose Add theme by pressing the
Add theme button or by pressing
ctrl-t.

2. Navigate to the directory where
you saved the coverages.

3. To display the content of the archives
with a yellow portfolio single click on
the portfolio.

When you have added the themes you can start working with them to create a good layout.

Rearrange the map to show only 
counties (in different colours), and 
surrounding areas (sea and 
countries). To do that you must put 
kust700 on top of lan700, and only 
have those two displayed. You must
also display both of the two using 
Unique values as Legend type. 
The colour for the terrestrial part of 
Sweden must also be set to 
transparent (for the lan700 theme to
shine through). Here is an example 
of how it could look.
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Set the colour of 
Sweden to transparent 
in order to let the 
counties be seen.



Open the layout that you 
created before, and press 

the View Frame tool  
and use the mouse to 
click and drag a small 
frame in the view. In the 
dialogue box that appears
select the view of 
Sweden that you just 
created from GSD700 
data. Rearrange the 
layout to fit both views. 
To pass the exercise, 
hand in the map to the 
teachers in paper or 
digital format.

Part 3 – Your turn with Gröna kartan

Create a New View in your project. Add all the themes building up Gröna Kartan (the general 
topographical map of Sweden in he scale 1: 50 000).
Gröna kartan in digital 
form is built from 3 
polygon themes, 2 line 
themes and 3 point 
themes – of which one 
is annotation and text 
labels. To know what is 
contained in the 
different themes you 
have to look at …
arbetsstuga2000/
html/kodgron.htm.

Use the themes of Gröna kartan over Örebro to create a thematic map. It is your choice to decide 
what the map should contain – but it must have at least one point, one line and one polygon theme 
– and it should have text labels. Below you see an example of a road map – which reveal more 
information as the scale increases. Colours are set to approximately match the printed version of 
Gröna kartan.
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1. Select the View Frame tool

2. Click and drag with the 
mouse to indicate a frame.

3. Rearrange the 
Layout



To pass the exercise, send the three maps in digital or analogue format to the teachers. To create a 
digital export make the layout the active document and choose Export under the File menu, and 
save the file in for instance JPEG format. Send the JPEG picture as attachment to the address of 
one of the teachers. 
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